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Introduction
Cisco TelePresence Management Suite Extension Booking API (Cisco TMSBA) gives developers access to 
Cisco TelePresence Management Suite (Cisco TMS) booking functionality. The API is also used by the 
Cisco TMS extensions for Microsoft Exchange and IBM Lotus Notes, and the Cisco TMSPE Smart 
Scheduler.

This document details the objects and entities used by Cisco TMSBA, includes references of the functions 
and objects available in the booking and remote setup APIs, explains the versioning logic,and provides usage 
patterns suggesting how an external user interface, booking database, or booking system may interact with 
Cisco TMS using the APIs. 

The target audience for this document is developers seeking to implement a data/audio/video conferencing 
booking solution that is not supported by Cisco TMS directly, or where existing Cisco TMS features do not 
provide the necessary interoperability. Such booking systems will be referred to as external booking systems 
in this document.
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API overview

This chapter provides an overview of the basic principles of Cisco TMSBA.

Functional overview 7
Cisco TMS entities 9
API versioning 10
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Functional overview
Cisco TMSBA makes it possible to let users book resources from custom booking applications (in this 
document referred to as "clients"), integrating the custom booking application with the Cisco TMS 
reservation database.

Using Cisco TMSBA to interact with Cisco TMS is the only safe and supported way of integrating third party 
or custom booking applications with Cisco TMS. The Cisco TMSBA is a versioned and stable interface into 
Cisco TMS, where backward compatibility is guaranteed in new releases.

Main features
Cisco TMSBA has three main features:

 n Importing and/or displaying Cisco TMS-managed resources in an external client or booking system.
 n Reading and displaying system availability information and bookings from the reservation database of 

Cisco TMS. This information can be used for replicating bookings from Cisco TMS to the external booking 
system.

 n Forwarding booking requests made by an external booking system to Cisco TMS. Forwarding a booking 
request to Cisco TMS lets the client utilize the routing logic of Cisco TMS, which determines whether 
network resources like an Multipoint Control Unit (MCU) are required, and automatically reserves these 
resources. The client therefore does not need to worry about infrastructure resources such as gateways 
and MCU port availability.

Booking ownership
The client can choose whether to authenticate with Cisco TMS as a service account or as the user actually 
making the booking. If authenticating as a service account, the client must explicitly specify the actual owner 
of the booking when performing the SaveConference function. If choosing this option, it is important that 
the service account is a member of a group having  Book on behalf of permissions in Cisco TMS.

IsTMSBookOnBehalfUser and IsBookonBehalfOfUser in the remote setup API can be used to 
assess whether a service account or other user has Book on behalf of permissions. The 
GenerateConferenceAPIUser function can be used for creating a service account. See Remote setup 
API reference [p.23].

Conference routing
When booking through the Cisco TMSBA, clients book endpoints only. Network infrastructure products, 
such as gateways and Multipoint Control Units (MCUs) are automatically added by Cisco TMS if needed. 
The settings under Administrative Tools > Conference Settings > Advanced Conference Options in 
Cisco TMS are used when routing conferences created through Cisco TMSBA.

Replication
Cisco TMSBA supports two-way replication between the client and Cisco TMS. If the client maintains its 
own copy of the reservation database, it must periodically ask Cisco TMS for changes.
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In Cisco TMS, all changes to bookings are tracked in the Cisco TMS (tmsng) database. The data in this table 
is available in Cisco TMSBA through the GetTransactionsSince function. This function gives the client 
a list of recent changes on the Cisco TMS side. This function should be run fairly often (such as every five 
minutes) so that the client and Cisco TMS reservation databases are in a consistent state.

Users in Cisco TMS have an "Exchange Integration Service Account" attribute. If this attribute is set to True, 
Cisco TMS sends an email message to the user every time a booking is created, changed, or deleted. By 
monitoring the mailbox of an "Exchange Integration Service Account" for new email, clients can be prompted 
to run the GetTransactionsSince function. 

However, this should not be the only mechanism triggering replication from the client side, as email may be 
delayed or fail to reach the mailbox of the "Exchange Integration Service Account". Clients should thus 
always call the GetTransactionsSince function periodically as a fallback mechanism.
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Cisco TMS entities

System
A system entity is any item that can be booked. Note that systems provisioned using Cisco TelePresence 
Management Suite Provisioning Extension  cannot be booked and are therefore not considered systems in 
this context.

There are two types of system entities: systems that are controlled by Cisco TMS (and thus receive 
phonebooks, generate CDRs and so on), and systems added to Cisco TMS as the "Room" and "Equipment" 
types. Other types of entries, such as phonebook entries or provision directory users, are not system entities 
in Cisco TMS.

Each system entity has its own TMS System Id, which is used to uniquely identify the system in Cisco 
TMS. A subset of this system  data is available in Cisco TMSBA through the GetSystemById function.

In the tmsng database, systems are stored in the objSystem table. System settings (such as SIP URIs, 
gatekeeper addresses, and software versions) are stored in the field_SystemField table. 

Conference
A conference entity, or booking, is a reservation in Cisco TMS. Each conference has a unique conference ID.

Conference and their attributes (ID, start time, end time, title, and so on) are stored in the tmsng database in 
the ScheduledCall table. Phonebook entries, systems, and external participants that are part of a 
conference are stored in the ScheduledParticipant table. The Cisco TMSBA functions that interact with 
conferences, such as GetConferenceById, get and set data to and from both tables..

User
The Cisco TMS user entity holds information about Cisco TMS users, such as their first name, last name, 
username, and email address. All users have a unique user ID.

This information is stored in the AclUser table in the tmsng database
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API versioning
Cisco TMSBA versioning is designed to provide a backwards compatible API to clients. This means that 
applications written for an older version of the API will keep working when upgrading to Cisco TMS with a 
newer version of the API.

Each SOAP message sent to the API by the client must announce which version it complies with in a 
header. The API will filter what is returned to the client based on this announced version. See The SOAP 
header [p.16].

Version history
Version 0 of the API corresponds to version 9 of Cisco TMS. Not all versions of Cisco TMS include changes 
to the API. 

Below is an overview of the last Cisco TMS versions that have included a new version of Cisco TMSBA.

API version Cisco TMS version

11 14.2

10 14.1.1

9 13.2

8 13.1.2

7 13.1

6 13.0.1

5 12.6

Versioning examples
When a change to the API is needed, the WSDL must be updated. The WSDL is the contract betweeen the 
API and the clients  and provides information covering all methods and data types, including values, that the 
API supports.

Time zone versioning

Cisco TMSBA allows each conference object to include a ConferenceTimeZoneRules element that 
contains an array of rules for the time zone (UTC offset) and daylight savings time. (For detail about this 
element, see ConferenceTimeZoneRules [p.39].)

This element was introduced in Cisco TMSBA version 11 with Cisco TMS 14.2. If a client is using version 10 
or earlier of the API, regardless of Cisco TMS version: 

 n Booking dates must be in UTC.
 n DayOfWeek values in recurrence patterns must be given in UTC if the API version used is 8 or later.
 n Dates are provided in UTC when retrieving conference information.
 n Cisco TMS uses the time zone rules of the server. 

Note that these conferences will be prone to DST change errors when the time zone of the client is not the 
same as the configured time zone on the Cisco TMS server. 
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Introducing a new bandwith value

When, for example, support for an additional bandwidth value is added to the API, the WSDL changes, and 
the version number is increased. If this new bandwidth value is added in version 9 of the API, every client 
declaring that they are using version 9 or later will get this new value returned from Cisco TMSBA. 

Clients that announce compliance to versions earlier than 9 will not get the new value returned. Instead , the 
API returns the special value default. The API allows all incoming values, but filters values going out. A client 
declaring a version lower than 9, that then enumerates a conference with the new bandwidth value,  will get 
the special value default returned. 

If the client uses this conference and updates the conference with bandwidth set to default, no change to the 
bandwidth value is made, as the API knows this special value means no changes should be made. 

This filtering of values that older clients do not understand makes the API backwards compatible; older 
clients built on older WSDLs can still use an API with a higher version.
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Using the APIs for remote setup and 
booking

This chapter presents the prerequisites and limitations for using the APIs for booking and remote setup, and 
outlines some suggestions for usage.

Usage requirements 13
Setting up your environment 15
The SOAP header 16
GUI pattern 17
Replication pattern 19
Limitations 21
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Usage requirements
This section describes the licensing, permission, and authentication requirements for using the APIs.

Licensing
One of the following licenses must be available to make full use of Cisco TelePresence Management Suite 
Booking API:

 n One Cisco TMS Application Integration License for each server using the API.
 n One Cisco TelePresence Management Suite Booking API license per 25 registered systems.

The following API functions require one of the above licenses:

 n GetRecordingAliases

 n GetTransactionsSince

 n SaveConference

 n SaveConferenceRecInstance

 n SaveConferences

The remaining API features do not require special licensing for use. Contact your Cisco reseller/partner for 
more licensing information.

Booking rights
Importing from Cisco TMS and booking meetings through the API requires authentication with Cisco TMS. 

There are two possible models for user authentication.

Service user books on behalf of users

The simplest approach is configuring one service user in Cisco TMS for your client, and granting this user 
Book on behalf of permissions as described below.

This model is only appropriate if all users with access to the client can be granted the same permissions in 
Cisco TMS, as booking on behalf of someone will create a new Cisco TMS user in the default group if the 
user does not already exist.

All users book for themselves

If you need to set up different booking rights per user, or block some users from booking altogether, each user 
must authenticate with Cisco TMS individually through the API.

Setting up permissions

All users who will book meetings using the API must be members of a group whose permissions include 
Booking. Users who book on behalf of others also require Book on behalf of permissions. 

Permissions in Cisco TMS are set on a group level. To modify the permissions set for a group:
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 1. Go to Administrative Tools > User Administration > Groups.
 2. Hover over the desired group, click the drop-down button and select Set permissions.
 3. In the Booking section, under Misc, check Booking and, if appropriate, Book on behalf of.
 4. Click Save.

NTLM authentication
On a default Cisco TMS installation, any API requires the use of Windows Challenge Response or NTLM 
authentication. 

Not all environments support this authentication mechanism (non-Windows based environments), and you 
therefore may need to allow for Basic Authentication:

 1. Open Internet Information Services manager on the Cisco TMS server.
 2. Expand Sites > Default Web Site and browse to  the /TMS/external/booking virtual directory.

 
 3. In the IIS section, double-click on Authentication.
 4. Right-click on Basic Authentication and select Enable.

Allowing Anonymous Authentication is not recommended and requires the IUSR_<machinename> to be 
given Book on behalf of permissions in Cisco TMS.

WebEx Enabled TelePresence requirements
In order to use Cisco TMSBA to book meetings that include WebEx, Cisco TMS must be set up with:

 n A WebEx Enabled TelePresence option key.
 n One or more WebEx sites.
 n Single sign-on or specified WebEx credentials for each user (not service user).

For guidance on setting up WebEx Enabled TelePresence, see WebEx Enabled TelePresence 2.0 
Configuration Guide for Cisco TelePresence Management Suite.
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Setting up your environment
Cisco TMSBA provides a Web Services API that interfaces with the Cisco TMS booking engine. Web 
Services allows for simple integration into most common language and programming environments. 

See your development tool reference for information on how to build implementation stubs to help speed the 
development of applications that use Web Services.

API locations
 n The WSDL file for the Cisco TMS remote setup API is located at: http://[Cisco TMS server]

/tms/external/booking/remotesetup/remotesetupservice.asmx
 n The WDSL file for Cisco TMSBA is located at: http://[Cisco TMS server]

/tms/external/booking/bookingservice.asmx

Microsoft Visual Studio .NET users can reference the APIs by selecting Project > Add Web Reference, or 
entering the URLs above. You will be required to authenticate through web services to create the reference. 

In a network load balancing scenario, use the virtual IP address or DNS name of the cluster for this task to 
allow failover for the API.

Security
We strongly recommend using SOAP for all requests. For security reasons, HTTP GET and POST are only 
accessible from localhost. To change this, modify the Cisco TMS web.config file.

Optional elements
Optional elements are indicated in different ways in the WSDL:

 n minOccurs = 0 means the element can be omitted from the request XML altogether.
 n nillable="true" means the element can hold an empty value. 

The combination of these two is an element that can be skipped and be set to null (not a value).

Boolean values
The boolean lexical forms "1" and "true" are interchangeable in SOAP.
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The SOAP header

ExternalAPIVersionSoapHeader
Each call made to the  Cisco TMSBA must include the following header specifying the version of the API. The 
value specified in ClientVersionIn is used by the API to determine the output from the function. The XML 
below describes the ExternalAPIVersionSoapHeader object that is common for all calls to the API.

Do not set a number greater than the latest version of the API, as this may break compatibility when using 
later revisions.

<ExternalAPIVersionSoapHeader xmlns="http://tandberg.net/2004/02/tms/external/booking/"> 
<ClientVersionIn>int</ClientVersionIn> <ClientIdentifierIn>string</ClientIdentifierIn> <C
lientLatestNamespaceIn>string</ClientLatestNamespaceIn> <NewServiceURL>string</NewService
URL> </ExternalAPIVersionSoapHeader>

If no version number is set, version 0 is the default. 

ContextHeader
Two flags control whether an email confirmation of the request will be sent out, and whether the confirmation 
will include conference information such as routing, list of participating systems, and so on. 

<ContextHeader xmlns="http://tandberg.net/2004/02/tms/external/booking/"> <SendConfirmati
onMail>boolean</SendConfirmationMail> <ExcludeConferenceInformation>boolean</ExcludeConfe
renceInformation> </ContextHeader>

The flags are not mandatory, and both are false by default. 
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GUI pattern
Cisco TMSBA can supply data to the front-end GUI of an external booking application. There are three 
information types.

System information
Information on Cisco TMS resources can be exported to an external application. By using the remote setup 
API, data on systems in Cisco TMS can be exported to a front-end GUI and used to display system entities 
available in Cisco TMS.

Get a list of available systems in Cisco TMS by using either:

 n GetSystems
 n GetSystemsForUser

These functions return lists of TMSSystem objects, that include information such as the ID of the system, to 
show in the front-end GUI. GetSystems will return all systems in Cisco TMS, while GetSystemsForUser 
will only return the systems the user has booking privileges for. If the external GUI application controls 
system access, use GetSystems and filter the systems in the application.

Availability information
Information on the availability Cisco TMS entities can be exported to an external application. Reservations in 
the Cisco TMS internal reservation database can be displayed and bookings filtering by users.

 n Get all Cisco TMS reservations between two specified dates by using GetConferencesForUser.
 n Get system availability information by using GetConferencesForSystems.
 n Get a specific conference, including any exceptions if it is a recurring conference, by using 

GetRecurrentConferenceById. This information can be used, for example, by an external application 
to display an availability calendar.

 n Filter availability information by using the Conference object.
 n The Remote Setup API function GetUsers returns all users registered in Cisco TMS. The output of this 

function can be used to display a drop-down list of all users in Cisco TMS, or show conferences booked by 
a specific person.

Booking management
The API allows you to forward booking requests from an external booking system to Cisco TMS, and reserve 
resources in Cisco TMS. (Information exchange: External Booking System > TMS).

 n Get Conference objects with default values for Conference properties defined in Cisco TMS by using the 
GetDefaultConference function. 

 n Retrieve existing conferences by using GetConferenceById, GetConferenceIdByExternalId or 
GetRecurrentConferenceById.

 n Save changes to a conference by editing the conference properties and using the function 
SaveConference. This will save the conference to Cisco TMS if the properties validate. If not, an 
exception will be raised.
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 n Delete a conference or series by using DeleteConferenceById. Beware that conference participants 
will be disconnected if the conference is deleted while it is active or connected.

 n Delete an occurrence of a series by using DeleteConferenceRecInstanceById.
 n Add recording to a conference by using GetRecordingAliases to get information about a user's 

recording aliases and use this information to add recording participant(s) to the conference.
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Replication pattern
The APIs can be used in conjunction with external booking applications that have their own reservation 
database. There are three main components.

Import
The API can automate importing systems from Cisco TMS into a third-party application, or this can be 
initiated by the user via a GUI.

Get a list of available systems in Cisco TMS by using either of the following from the remote setup API:

 n GetSystems
 n GetSystemsForUser

These functions return lists of TMSSystem objects, and information such as the ID of the system, for use by 
a third party application. GetSystems will return all systems in Cisco TMS, while GetSystemsForUser 
will return only the systems the user has booking privileges for. If the external application controls system 
access, use GetSystems and filter the systems in the application. 

Replication
External booking systems can keep track of booking transactions on the Cisco TMS server, and replicate 
bookings made using Cisco TMS. This part does not apply to external GUI front ends that do not have their 
own reservation database.

Get a list of transactions listed by transaction ID by using the GetTransactionsSince function. All 
conferences have a transaction ID property

The list of transactions contains:

 n The transaction type (New, Update, and Delete)
 n An associated conference ID. 

Use GetConferenceById to get an updated Conference object and update the conference with the 
external source. The current transaction ID should then be updated to the last conference’s TransactionId.

Booking
The API allows you to forward booking requests from an external booking system to Cisco TMS, and reserve 
the resources there.

 n Get Conference objects with default values for Conference properties defined in Cisco TMS by using 
GetDefaultConference.

 n Retrieve saved conferences by using one of the following functions:
 l GetConferenceById
 l GetConferenceIdByExternalId
 l GetRecurrentConferenceById
 l GetConferencesForUser
 l GetConferencesForSystems
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 n Save changes to a conference, by editing the conference properties and use function SaveConference. 
This will save the conference to Cisco TMS if the validation of the properties is OK. If not, an exception will 
be raised.

Availability
The API allows you to display  reservations from the Cisco TMS internal reservation database.  
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Limitations

WebEx booking limitations
WebEx booking does not support all recurrence patterns and options supported by Cisco TMS:

 n Exceptions from a recurrence pattern (moving or updating one or more meetings) are not supported.
 n Some advanced recurrence patterns are not supported.

When WebEx is not supported for a particular booking, the booking will fall back to telepresence only.

WebEx-only meetings not supported

WebEx-only meetings should not be booked using Cisco TMSBA. If using Cisco TMS to create a conference 
that includes WebEx without including any telepresence participants, telepresence resources will still be 
taken up, as an MCU will connect to the conference. The API will book the conference, but return a warning 
when such conferences are created.

Also note that WebEx bookings do not support time zone rules.

Other booking limitations
Booking through Cisco TelePresence Management Suite Extension Booking API has the following 
limitations:

 n The use of setup and teardown buffers in Cisco TMS is not supported.
 n Cascading to additional MCUs when the number of participants exceeds the capacity of the first MCU is 

not supported.
To support such scenarios, set up Cisco TelePresence Conductor as the default MCU in Cisco TMS.

 n When a service user is performing all bookings, the booking permissions are the same for all users. 
Individual permissions and restrictions are ignored.

 n You cannot move a meeting from the past to the future.

Modifying ongoing meetings

Updating a single meeting that is currently ongoing is possible, but will not always be successful. 

For example:

 n changing the start time may disrupt the meeting.
 n if the meeting is  using an MCU that does not support WebEx, WebEx may not be added, as the meeting 

would have to be disconnected and re-routed for this to work.

If modifying a recurrent series while an instance is ongoing:

 n changing the start time will be applied to the entire series, and the ongoing meeting may be disrupted.
 n making any other modifications will be applied to upcoming instances only, and the ongoing meeting will be 

marked as an exception in Cisco TMS.

Unused values
The following values are present in the API, but not in use:
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Function Attribute Value

RecurrencePattern PatternEndType Never

RecurrencePattern FrequencyType  n Secondly 
 n Minutely
 n Hourly
 n Yearly

Participant ParticipantCallType User

ISDNBandwith Bandwidth Max

ISDNBandwith IPBandwidth Max
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Remote setup API reference

The remote setup API accommodates the setup of users and systems prior to using the Booking API.

TMSSystem object 24
TMS user object 27
Remote Setup API functions 28
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TMSSystem object
The TMSSystem object contains information about a system in Cisco TMS. This object is used to read 
information, as the remote setup API does not support updating system information in Cisco TMS. 

Use this object to import the required information into the third party application. The SystemId is required to 
connect the application entity with the system in Cisco TMS. In addition other information can be imported 
and shown for informative purposes, for example the name of the system.

TMSSystem
SystemId The ID of the system in Cisco TMS. Use this to refer to the associated system in Cisco TMS 

from your application. For example, when booking a conference, insert the IDs of the 
chosen systems into the Conference object.

SystemName The name of the system in Cisco TMS. Use this to display the name of the system in your 
application.

Contact The system contact associated with the system in Cisco TMS.

Manufacturer The manufacturer of the system. For example, Cisco.

Description A textual description stored in Cisco TMS. This file can contain information such as the 
number of chairs in the meeting room where the system is located.

SystemType The type of system. For example, Cisco TelePresence System EX90.

QNumber The IP or DNS address of the system.

ISDNNumber The ISDN number of the system.

Location The ISDN location where the system is located.

NetworkAddress The fully qualified ISDN number of the system. A fully qualified ISDN number always 
includes the country code and area code. This is not implemented.

WebInterfaceURL The http address of the web server of the system.

SIPUri The SIP URI of the system.

H323Id The H.323 ID of the system.

E164Alias The E.164 alias of the system.

TimeZone The time zone where the system is located.

SystemCategory The system category.

SystemStatus The status of the system.

TimeZone
TimezoneName The name of the time zone.

StartTimeDTS The start date of daylight saving time.
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EndTimeDTS The end date of daylight saving time.

GMTOffset The GMT (UTC) offset.

SystemCategory
SystemCategory An enumeration value of what category of system this is. The available options are:

 n Endpoint
 n Equipment
 n Room
 n Recording

SystemStatus
SystemStatus An enumeration with the status of the system when this function is call. Note that the status of 

the system can change frequently. The possible values are:

 n Alive
 n Idle
 n InCall
 n NoResponse
 n Unknown

TMSSystem object XML
The XML below describes the TMSSystem object. Following the XML is a description of the elements and 
what information each element it contains.

Note that as all fields are not required, the output may contain less system information than the object can 
hold.

<TMSSystem> 
  <SystemId>long</SystemId>
  <SystemName>string</SystemName>
  <Contact>string</Contact>
  <Manufacturer>string</Manufacturer>
  <Description>string</Description>
  <SystemType>string</SystemType>
  <NetworkAddress>string</NetworkAddress>
  <Location>string</Location>
  <ISDNNumber>string</ISDNNumber>
  <QNumber>string</QNumber>
  <WebInterfaceURL>string</WebInterfaceURL>
  <SIPUri>string</SIPUri>
  <H323Id>string</H323Id>
  <E164Alias>string</E164Alias>
  <TimeZone>
   <TimezoneName>string</TimezoneName>
   <StartTimeDTS>string</StartTimeDTS>
   <EndTimeDTS>string</EndTimeDTS>
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   <GMTOffset>string</GMTOffset>
  </TimeZone>
  <SystemCategory>
   <systemCategory>Endpoint or Equipment or Room or Recording</systemCategory>
  </SystemCategory>
  <SystemStatus>
   <SystemStatus>Alive or Idle or InCall or NoResponse or Unknown</SystemStatus>
  </SystemStatus>

</TMSSystem>
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TMS user object
The Cisco TMS user object contains information about Cisco TMS users. Use this object to access 
information about users in Cisco TMS. The XML document below describes the User object. Following the 
XML is a description of the elements and what information each element it contains.

User
Attribute Description

DisplayName The display name of the user.

EmailAddress The e-mail address of the user.

FirstName The first name of the user.

LastName The last name of the user.

UserName The Windows login name of the user.

IsHiddenUser Boolean value used to represent whether this is a normal user (True), or a service account 
(False) that normally should not be displayed in a list of users.

TimeZone The time zone where the user is located. Uses the same TimeZone object as TMSSystem.

TMS user object XML
<User>
     <DisplayName>string</DisplayName>
     <EmailAddress>string</EmailAddress>
     <FirstName>string</FirstName>
     <LastName>string</LastName>
     <UserName>string</UserName>
     <IsHiddenUser>boolean</IsHiddenUser>
     <TimeZone>
         <TimezoneName>string</TimezoneName>
         <StartTimeDTS>string</StartTimeDTS>
         <EndTimeDTS>string</EndTimeDTS>
         <GMTOffset>string</GMTOffset>
     </TimeZone>

</User>
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Remote Setup API functions
This reference section describes all the available functions of the remote setup API.

DisableConferenceAPIUser
This function is used to disable a ConferenceAPI user. E-mail notifications for the user are disabled, and the 
user is removed from all groups in Cisco TMS except the Users group. This is done to keep references valid.  
Executing this function requires Cisco TMS Site Administrator privileges.

This function is typically used during uninstall procedures.

Supported parameters:

userName The full username of the user to delete in NT4 style (domain\username).

Returned data:  None.

GenerateConferenceAPIUser
This function generates a Cisco TMS Booking API account in the default user container on the Cisco TMS 
server, including registering the user in Cisco TMS. It is typically used during installation/setup procedures.

The user will be:

 n Hidden from normal user lists.
 n Added to the Site Administrator Group.
 n Configured to receive e-mail event scheduling notifications for all creation/update/deletions of bookings. 

These are typically used for updating the external booking system with changes done on the Cisco TMS 
server.

In order for the function to complete, the current user must be:

 n A Cisco TMS Site Administrator
 n A local computer administrator 

Supported parameters:

userNameBase The base portion of the user name. If a user with the name already exists a numeric 
postfix is added (for example tms-admin ==> tms-admin1).

encPassword A base64 encoded password that is to be used for the newly created user.

emailAddress The email address of the user.

sendNotifications Whether the user should receive scheduling notifications.

Returned data: The username of the created user (NT4 domain/username style).

GetConferenceLanguages
Returns an array of Language objects.
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Supported parameters: None

 Returned data:  An array of supported conference languages in TMS. The CultureInfo field specifies the 
exact variety of a language and can be used to set the ConferenceLanguage on the Conference object when 
scheduling conferences.

GetSystemById
This function returns information about a specific system. If the system is not found, this causes an error.

Supported parameters:

TMSSystemId System ID as given in Cisco TMS.

Returned data: A TMSSystem object.

If the provided ID does not exist, this will cause an error. See the section Error codes and error handling 
[p.53].

GetSystems
This function returns all endpoints and rooms registered in Cisco TMS. Note that network systems, such as 
a Cisco TelePresence MCU, are not returned since they are normally not booked by the users, but are added 
to the conference by Cisco TMS if required. 

Typically used during setup of resources in the external booking system to connect resources in Cisco TMS 
with resources in the external booking system.

Supported parameters: None

Returned data: An array of TMSSystem objects.

GetSystemsForUser
This function returns all endpoints and rooms that can be booked by the current user, the account credentials 
are used to communicate with  Cisco TMSBA. 

Note that network systems, such as a Cisco TelePresence MCU, are not returned since they are normally 
not booked by the users, but are added to the conference by Cisco TMS if required. 

Typically used in the external booking system to list Cisco TMS resources in external booking system.

Supported parameters: None.

Returned data: An array of TMSSystem objects.

GetUsers
This function returns all users registered in Cisco TMS. 

This function is typically used in the front-end GUI to provide a list of Cisco TMS users, and can filter output 
from the  Cisco TMSBA based on users from this output.

Supported parameters: None.
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Returned data: An array of User objects.

IsAlive
This function checks the connection to the web services of Cisco TMS.

It is typically used during installation to check the URL to this web service.

Supported parameters: None

Returned data: A boolean value true/false, which is true if the connection works.

IsBookOnBehalfOfUser
Checks whether the specified user (not the current user) is a member of a Cisco TMS group that has 
permissions to book on behalf of other users. 

Supported parameters:

user The Cisco TMS user ID of the user for whom to check permissions.

Returned data: A boolean value true/false, which is true if the user if the user has permissions to book on 
behalf of other users in Cisco TMS.

IsLocalAdmin
This function checks whether the current user can create local or Active Directory accounts in the default 
user container on the Cisco TMS server. 

This is typically used during installation to check whether the user installing the integration has sufficient 
access to Active Directory. This function must return True in order for the GenerateConferenceAPIUser 
function to succeed.

Supported parameters: None.

Returned data: A boolean value true/false, which is true if the user is a local administrator.

IsTMSBookOnBehalfUser
Checks whether the current user is a member of a Cisco TMS group that has permissions to book on behalf 
of other users. 

Supported parameters: None.

Returned data: A boolean value true/false, which is true if the user has permissions to book on behalf of 
other users in Cisco TMS.

IsTMSServiceUser
This function is used to check whether the current user is flagged as an Exchange Integration user and has 
access to book on behalf of other users. 
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This is typically used during installation to check whether the user installing the integration has sufficient 
access permissions for the Cisco TMS server.

Supported parameters: None.

Returned data: A boolean value true/false, which is true if the user is a Cisco TMS service user.

IsTMSSiteAdmin
This function checks whether the current user is a member of the Cisco TMS Site Administrators group. 

This is typically used during installation to check whether the user installing the integration has sufficient 
permissions towards the Cisco TMS server. This function should return True for the 
GenerateConferenceAPIUser function to succeed.

Supported parameters: None.

Returned data: A boolean value true/false, which is true if the user is a Cisco TMS Site Administrator.

SetPrimarySystem
Supported parameters:  

primSys A Cisco TMS system ID.

Returned data: A boolean value true/false, which is true if it is possible to set the Primary System for the 
current user.
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Booking API reference

The booking API lets you schedule conferences in    Cisco TMS using a third-party client, and replicate 
existing bookings between the two. This chapter is a reference to the conference object and to all available 
functions and parameters.

Conference object 33
Booking API functions 46
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Conference object
This object can be used to read and write 

 n Conference properties such as Start Time, End Time, Conference Title, and Conference Password.
 n Conference call-related values such as Bandwidth, Picture mode, and Encryption mode.

All conference resources, including video participants, audio participants, phone book participants, external 
participants and so on, are held in this object, together with routin g information for connecting the resources. 
You also use the Conference object to define the conference type, that is, how the conference should be 
connected.

Conference data can be saved/updated, and handled by Cisco TMS using the SaveConference function 
described below.

Conference
Attribute Read/Write Description

ConferenceId r/w, 
optional

When using SaveConference:

 n Set to -1 to create a new conference using 
GetDefaultConference.

 n Set to a value greater than 0 to update the existing conference 
that has the given ID in the Cisco TMS database.

Title r/w, 
optional

If no title is specified, the Cisco TMS default will be used.

StartTimeUTC r/w, 
required

The start and end times of the conference in UTC format. See 
http://www.w3.org/TR/NOTE-datetime for more information. 

Only UTC times, ending with Z, are supported. Example: 1975-06-
0123:32:11Z.

EndTimeUTC r/w, 
required

RecurrenceInstanceIdUTC r, only used 
when 
getting 
conference 
from Cisco 
TMS

Gives the start date of the instance of the meeting according to the 
recurrence pattern. If this is different from StartTimeUTC, the 
meeting is an exception to the recurrence pattern.

Only UTC times, ending with Z, are supported. Example: 1975-06-
0123:32:11Z.

RecurrenceInstanceType r, only used 
when 
getting 
conference 
from Cisco 
TMS

If this string contains the value ‘modify’  it means that the particular 
meeting is an exception to a recurrence pattern. It the string 
contains "deleted", it is a meeting that has been deleted from a 
series of recurring meetings.

FirstOccurrenceRec
InstanceIdUTC

r, only used 
when 
getting 
conference 
from Cisco 
TMS

Gives the start date of first instance of the meeting according to the 
recurrence pattern.

Only UTC times, ending with Z, are supported. Example: 1975-06-
0123:32:11Z.
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Attribute Read/Write Description

RecurrencePattern r/w, 
optional

Sets the recurrence patterns for recurrent meetings. This is not 
valid if you call the SaveConferenceRecInstance function. See 
RecurrencePattern [p.43].

OwnerId r/w, 
optional

Elements used to look up the owner of the conference.

 n If OwnerUserId is specified, it will be looked up in the Cisco TMS 
database.

 n If no OwnerUserId is specified, but the OwnerUserName is set, it 
will be looked up in the Cisco TMS database. If not found, a 
lookup will also be performed in Active Directory if import is 
enabled.

 n If neither OwnerUserId nor OwnerUserName are specified, the  
OwnerEmailAddress will be looked up in Cisco TMS. If not 
found, an AD lookup will be performed if import is enabled.

OwnerUserName w, optional

OwnerEmailAddress w, optional

OwnerFirstName w, optional These elements are not used for lookup, but can be stored for the 
new user if no it does not exist in Cisco TMS and AD lookup is not 
enabled.OwnerLastName w, optional  

ConferenceType r/w, 
optional

Setting determining how the conference will be launched. The 
valid values are:      

 n Automatic Call Launch, connect all participants at conference 
start time and disconnect them again at conference end time. 

 n One Button to Push,  allows for OBTP call setup on supported 
systems.

 n Manual Call Launch,  the conference master participant will be 
asked to connect the call at conference start time.

 n Reservation Only, reserve the participants for the conference 
duration, but do not create a route.

 n Ad-Hoc conference, a conference resolved, but not initiated, by 
Cisco TMS.

 n Default, keep the conference type specified on initial booking of 
the conference.

If unspecified, the default conference type configured in Cisco 
TMS will be used.

Bandwidth (Discontinued) — This item has been deprecated and is included for backwards 
compatibility only. Use ISDNBandwidth and IPBandwidth to 
control the conference bandwidth. See ISDNBandwidth [p.44].

PictureMode r/w, 
optional

If not 
specified, 
Default is 
assumed

The picture mode/conference layout to use for a conference using 
Cisco TelePresence MPS. The valid values are: 

 n Continuous Presence,
 n Enhanced CP,
 n Voice Switched, 
 n Default, keep the picture mode specified on initial booking of the 

conference.

If unspecified, the default conference type configured in Cisco 
TMS will be used.
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Attribute Read/Write Description

Encrypted r/w, 
optional

If not 
specified, 
Default is 
assumed

The encryption mode for the conference. The valid values are: 

 n Yes
 n No
 n If Possible
 n Default, keep the picture mode specified on initial booking of the 

conference.

If unspecified, the default encryption setting configured in Cisco 
TMS will be used.

DataConference r/w, 
optional

Legacy method of adding WebEx to a conference. See 
ExternalConference below for the preferred method.

The valid values are: 

 n Yes
 n No (default)
 n  If Possible
 n Default, keep the data conference setting specified on initial 

booking of the conference.

ExternalConference r/w, 
optional

Used to include a web conference with the telepresence meeting. 
The supported conference type is WebEx. See 
ExternalConference [p.37].

ShowExtendOption r/w, 
optional

If not 
specified, 
Default is 
assumed

Set this value to specify extend option behavior when the 
scheduled conference is close to ending.

 n Yes—prompt the VC Master (the first endpoint in the participant 
list) to extend the conference

 n No—do not offer to extend conference
 n Automatic Best Effort—automatically extend conference
 n Default—keep the Show Extend Option setting specified on 

initial booking of the conference.

If unspecified, the default Show Extend Option defined in the 
Administrator Tools Page in Cisco TMS is used.

Password r/w, 
optional

The numeric PIN that conference participants must enter to join the 
call. Auto-generated password may be added if Cisco TMS is set 
up to create them.

BillingCode r/w, 
optional

The billing code to use for the conference. If Cisco TMS requires 
billing codes, this field must be specified and will be validated 
against the list of billing codes in Cisco TMS.  If no match is found, 
the conference will not be created and the API will throw an 
"Invalid billing code" exception.

This setting is blank by default.

ISDNRestrict r/w, 
optional

Whether the ISDN channels should be restricted to use 54k and 
not 64k.

The default is No.
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Attribute Read/Write Description

ConferenceInfoText r, only used 
when 
getting 
conference 
from Cisco 
TMS.

Information on how the conference will connect, including routing 
information. Based on Cisco TMS templates.

ConferenceInfoHTML r, only used 
when 
getting 
conference 
from Cisco 
TMS.

Information in HTML markup on how the conference will connect, 
including routing information.  Based on Cisco TMS templates.

UserMessageText r/w, 
optional

A user definable text/description of the conference. The default is 
blank.

ExternalSourceId, 
ExternalPrimaryKey

r/w, 
optional

An external source and ID definable by the client, this is used to 
synchronize the Cisco TMS database with the external sources 
database. If Cisco TMS is given a value for these fields, Cisco TMS 
will return the value for all instances of the same conference. 
Default is blank.

Participants r/w, 
required

List of conference participants. When calling 
GetDefaultConference, the participant list will be empty.

RecordedConferenceUri r, only used 
when 
getting 
conference 
from Cisco 
TMS

If the conference is recorded, this is the URI of the conference 
recording.

WebConferencePresenterUri r, only used 
when 
getting 
conference 
from Cisco 
TMS

The URIs that the presenter and attendees respectively will use to 
join WebEx when the legacy DataConference attribute has been 
used. See ExternalConference for the recommended way to add 
WebEx.

WebConferenceAttendeeUri r, only used 
when 
getting 
conference 
from Cisco 
TMS
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Attribute Read/Write Description

ISDNBandwidth r/w, 
optional

The ISDN and IP bandwidths of the conference. If unspecified, the 
default ISDN bandwidth configured in Cisco TMS will be used. 
The valid values are:

 n 1b/64kbps
 n 2b/128kbps
 n 3b/192kbps
 n 4b/256kbps
 n 5b/320kbps
 n 6b/384kbps
 n 8b/512kbps
 n 12b/768kbps
 n 18b/1152kbps
 n 23b/1472kbps
 n 30b/1920kbps
 n 32b/2048kbps
 n 48b/3072kbps
 n 64b/4096kbps
 n 7b/448kbps
 n 40b/2560kbps
 n 96b/6144kbps
 n Max, use as much bandwidth as available and necessary.
 n Default,  keep the bandwidth specified on initial booking of the 

conference.

IPBandwidth r/w, 
optional 

ConferenceLanguage r/w, 
optional

If not 
specified, 
default is 
assumed

The language used for email invitations and other notifications 
regarding the meeting. A list of supported languages is available 
from the Remote Setup API, see GetConferenceLanguages [p.28].

ConferenceTimeZoneRules r/w, 
optional

An array of time zone rules for the conference.

See ConferenceTimeZoneRules [p.39].

ExternalConference

The only supported type of external conference is currently WebEx.

WebEx

There are two ways to add WebEx to a telepresence booking:

 n Setting ExternalConference with a WebEx element inside of it  initiates the addition of WebEx to a 
booking, or an update to existing WebEx information for a conference. This is the recommended way to add 
WebEx.

 n The legacy way: Set    DataConference to Yes or If possible and externalconference is not set.

To remove WebEx from a booking:
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 n Set an empty ExternalConference (no WebEx element).
 n The legacy way: Set dataconfmode to Off, do not include ExternalConference.

Note that as WebEx does not support exceptions (meetings in a series that diverge from the series pattern), 
the WebEx calendar may become out of sync with the Cisco TMS if using the API to create a series with 
exceptions.

WebEx also cannot be added to a single instance of a recurrent series, or removed from a single instance of a 
series.

Attribute Read/Write Description

MeetingKey r/w The WebEx meeting number.

SipUrl r/w The conference SIP URL.

ElementsToExclude r/w Elements to exclude from conference invitation email. The following 
elements may be excluded:

 n None
 n MeetingPassword
 n HostKey
 n LocalCallInTollFreeNumber
 n GlobalCallInNumberUrl

MeetingPassword r/w The password required to join the WebEx conference.

JoinMeetingUrl r/w The URL that attendees will use to join the conference.

HostMeetingUrl r/w The URL that the host will use to join the conference.

HostKey r/w Specifies the host key, which may be used to pass and reclaim the 
host role during a  WebEx conference.

JoinBeforeHostTime r/w Whether participants are allowed to join the conference up to 15 
minutes before the scheduled start time.

Telephony r/w Phone numbers for joining the conference. The type is 
WebExTelephony, see below.

TmsShouldUpdateMeeting r/w Whether a WebEx meeting originally booked by an external client may 
be updated by Cisco TMS. If updating the meeting is not possible, the 
request will return a warning.

SiteUrl r/w URL of the WebEx site booked for the conference. This site must 
already be added to Cisco TMS, or the request will return an error.

UsePstn r/w Whether the WebEx site for the conference is set up to use PSTN. 
When the conference is externally owned (see below), this setting will 
always be read/overwritten from the WebEx site configured in Cisco 
TMS.

OwnedExternally r/w Whether the WebEx meeting was originally booked by an external 
client.

Errors r/w Errors from WebEx.

Warnings r/w Warnings from WebEx.
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WebexTelephony

Attribute Read/Write Description

 LocalCallInTollNumber r/w Specifies the backup toll call number.

LocalCallInTollFreeNumber r/w Specifies the toll-free call in number.

GlobalCallInNumberUrl r/w Specifies a call-in number for out-of-country participants.

PstnDialInNumber r/w Number to dial in if using PSTN. This element is required if UsePstn 
is true.

DtmfSequence r/w PSTN only. WebEx format, do not convert. This element is required if 
UsePstn is true.

For further detail on WebEx configuration and options, see your WebEx Site Administrator's User Guide or 
online help, linked from your WebEx site.

ConferenceTimeZoneRules

See  Time zone versioning [p.10] for information on how time zones are handled with versions of the API that 
do not support the model described below.

Booking

When booking a new conference using API version 11 or later, Cisco TMS will:

 n Use the time zone rules supplied with the booking, if available and valid.
 n Use the time zone of the conference owner in Cisco TMS if no time zone rules are supplied with the 

booking.

Note that each booking, be it for a single meeting or a series, may only have one set of time zone rules. If 
different rules are specified for start time and end time, the time zone rules for end time will be ignored.

Updating

When updating a conference:

 n Setting the time zone to null, once set, is not a valid option. Cisco TMS will keep the original time zone of 
the conference, even if the conference is being modified by a client or API version that does not support 
time zone rules.

 n Supplying the new time zone rule as part of the Conference object will change the actual time zone of this 
conference.

Note that modifying the time zone of an existing meeting is only supported through the API, not in the Cisco 
TMS user interface.

TimeZoneRule

ConferenceTimeZoneRules contains an array of TimeZoneRule elements. If a change to DST rules is 
scheduled for a time zone, the new rule set should be included as early as possible to ensure that 
conferences scheduled to happen after the rule change will happen at the intended time.
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Note that no rules can overlap in time, and no start day can be the same day as the end day of the previous 
rule.

Each TimeZoneRule element may contain the attributes below.

Attribute Read/Write Description

ValidFrom  Use SOAP dateTime to specify the exact time from which the rule is 
valid. 

Here, you must use the given time zone's standard time and provide it 
as a datetime of the unspecified kind, or an exception will be thrown. 

Do not use UTC or UTC formatting.

Id optional Time zone rule set name.

The Id must be the same for each TimeZoneRule in the  
ConferenceTimeZoneRules array. If they are not the same, the last Id 
will be used.

DisplayName  Time zone rule set description that will be displayed in Cisco TMS for 
any booking using this rule. Note that there is no mechanism for 
localizing this, the textual description will be used as-is.

BaseOffsetInMinutes  UTC offset outside of daylight savings time (DST), in minutes. The offset 
must not exceed 14 hours/-14 hours.

DaylightOffsetInMinutes  Offset from the base offset during DST, in minutes. The sum of this offset 
and the base offset must not exceed 14 hours/-14 hours. . If set to 0, 
Cisco TMS will not parse the defined Daylight or Standard rules, but 
create a rule without DST changes

Daylight optional Set for any time zone that has rules for entering (Daylight) and leaving 
(Standard) DST. The type is TimeChange, see below.

If either of these fields is undefined/null, and BaseOffsetInMinutes is set 
as more than 0, Cisco TMS will throw an exception.

Standard

TimeChange

Attribute Read/Write Description

ChangeSecondAtDay  The exact number of seconds from midnight that the 
change will occur. Must be between 0 and 86399.

TimeChangeAbsoluteRule r/w, defining one of 
these two is mandatory

Used if DST changes happen at fixed dates. Specify the  
month and the day of the month.

 n Valid month values are between 1 and 12.
 n Valid day of the month values are between 1 and 31.

TimeChangeRelativeRule Used if the DST change date is relative, such as 
 the third sunday of a particular month. Specify the month, 

the week of the month, and the day of the week. 
 n Valid month values are between 1 and 12
 n Day of the week must be between 0 (Sunday) and 6 

(Saturday). Default is 0
 n Week of the month must be between 1 and 5. Default is 

5, last week of the month.
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If time zone validity rules are violated, the API will throw an exception, see Error codes and error handling 
[p.53].

Participant
Attribute Read/Write Description

ParticipantId r/w – 
optional

For Cisco TMS System Entities, this value must be the SystemId of the 
system. For external participants this value may be set, but is not required. If 
not set for external participants, Cisco TMS will create an ID with an integer 
greater than 0.

NameOrNumber r/w – 
optional

For external participants, the participant name for dial-ins, or the fully 
qualified number to dial for dial-outs. 

For example:

 n A dial-in can be given the value Placeholder for John Doe.
 n An ISDN dial-out would be given the value +1 (555) 1231234. This 

value is required for external dial-out participants, and must be the fully 
qualified number to dial. 

Fully qualified numbers are of the format +CC (AC) BN  where:

 n CC=Country Code
 n AC=Area Code
 n BN=Base Number

If the country does not use Area Codes, that element can be omitted 
completely, and the format would be +CC BN.
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Attribute Read/Write Description

ParticipantCallType r/w – 
required

The participant type. Valid values are:      
 n TMS, a TMS System Entity. When this is specified, the ParticipantId must 

be the Cisco TMS System Entity ID as given in Cisco TMS.
 n IP Video <- or ISDN Video <-, an IP/ISDN video dial-in. If this is specified, 

you may give the participant a name using the NameOrNumber field. 
Cisco TMS will automatically give the participant an ID (less than 0).

 n IP Tel <- or Telephone <-, an IP/ISDN audio dial-in. If this is specified, you 
may give the participant a name using the NameOrNumber field. Cisco 
TMS will automatically give the participant an ID (less than 0).

 n IP Video -> or ISDN Video ->, an IP/ISDN video dial-out site. Specifying 
this value requires providing Cisco TMS with the number to use in the 
NameOrNumber field. (Formats: ISDN: +1 (555) 1231234, H.323 IP 
E.164: 12312321, H323 IP Address: 10.0.0.10).

 n IP Tel -> or Telephone ->, an IP/ISDN audio dial-out site. If this is specified, 
you must give Cisco TMS the number to use in the NameOrNumber field 
(Formats: ISDN: +1 (555) 1231234, H.323 IP E.164: 12312321, H.323 
IP Address: 10.0.0.10). Call will be placed using 64kbps/54kbps 
depending on restrictions.

 n Directory, a Cisco TMS phone book entry.
 n SIP -> or SIP <-, a SIP video participant. The value can be a number or a 

URI.
 n SIP Tel -> or SIP Tel <-, a SIP audio participant. The value can be a 

number or a URI.
 n TMS Master Participant, the conference master. When this entity is 

specified, the ParticipantId must be the Cisco TMS System Entity ID as 
given in Cisco TMS. It is only possible to specify a single  Master 
Participant per conference, which must be a Cisco TMS System.

The User participant type is not currently supported by the API.
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RecurrencePattern
Attribute Read/Write Description

FrequencyType r/w 
required

The frequency of the recurrence rule.

Legal values are: 

 n Daily
 n DailyWeekday
 n Weekly
 n Monthly
 n Default

Default is used by Cisco TMSXE to identify single 
telepresence meetings that are part of a non-telepresence 
series on the client side.

Available, but unsupported values are: 

 n Secondly
 n Minutely
 n Hourly
 n Yearly

Interval r/w 
required

Every X day/week/month as selected by FrequencyType

DaysOfWeek Days of week in UTC if relevant for your 
FrequencyType.Valid values are full names of days, 
capitalized.
 n Set the day if the meeting is to occur on one fixed day of 

the week.
 n Set all days for a meeting that occurs every day.
 n Set all weekdays for a meeting that occurs every 

weekday.
 n Set Saturday and Sunday for a meeting that occurs only 

on weekends.

FirstDayOfWeek First day of week. Used to split DaysOfWeek into "every X 
weeks" weekly patterns. The default value is Sunday.

BySetPosition Relative position of the instance in a pattern. For example, in 
a monthly pattern, a value of 2 means second day of the 
month, -1 means last day of the month. The allowed days 
must be defined in DaysOfWeek. 0 means every X day of 
the month.

PatternEndType End type: 

 n by number of occurrences
 n by date
 n never (not currently supported)

PatternEndDateUTC In the case where PatternEndType is by date, this gives the 
end date of the recurrence pattern.
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Attribute Read/Write Description

FirstOccurrenceRecInstanceIdUTC Gives the original start time of the first occurrence of this 
meeting. If the meeting is not an exception to the recurrence 
pattern, this time will be the same as the start time of the 
meeting. If the meeting time for the occurrence has been 
modified, this string gives the original start time according to 
the recurrence pattern.

This field is only populated by the API when 
PatternEndType is by number of occurrences.

PatternInstances In the case where PatternEndType is by number of 
instances, defines the number of instances to generate from 
the pattern.

Exceptions Exceptions to the pattern are supported using the 
GetRecurrentConferenceById and SaveConference 
functions. To get a conference with all its exceptions, use 
GetRecurrentConferenceById. 

To update a conference with exceptions, use the 
SaveConference function providing the exceptions in the 
RecurrencePattern.Exceptions array before saving the 
conference. 

As an alternative:

 1. Use GetConferenceIdByExternalId with 
RecInstanceIdUTC (UTC string that points to the UTC 
day of the instance) to get conference id for the instance.

 2. Use SaveConferenceRecInstance to save this 
exception.

ISDNBandwidth
Attribute Read/Write Description

Bandwidth The ISDN bandwidth that will be used when dialing the conference participants and 
when creating the conference. Note that Max is not currently supported. Example 
value 3b/192kbps. If Default is selected, the value is set to the default conference 
ISDN bandwidth as defined in the Administrator Tools page in Cisco TMS.

IPBandwidth The IP bandwidth that will be used when dialing the conference participants and 
when creating the conference. Note that Max is not currently supported. Example 
value 3b/193kbps. If Default is selected, the value is set to the default conference 
IP bandwidth as defined in the Administrator Tools page in Cisco TMS.

Conference object XML
The XML document below describes the Conference object.

  <Conference> <ConferenceId>int</ConferenceId> <Title>string</Title> <StartTimeUTC>strin
g</StartTimeUTC> <EndTimeUTC>string</EndTimeUTC> <RecurrenceInstanceIdUTC>string</Recurre
nceInstanceIdUTC> <RecurrenceInstanceType>string</RecurrenceInstanceType> <FirstOccurrenc
eRecInstanceIdUTC>string</FirstOccurrenceRecInstanceIdUTC> <RecurrencePattern> <Frequency
Type>Daily or DailyWeekday or Weekly or Monthly or Yearly or 
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   Secondly or Minutely or Hourly or Default</FrequencyType> <Interval>int</Interval> <Day
sOfWeek> <DayOfWeek>Sunday or Monday or Tuesday or Wednesday or Thursday or Friday 
   or Saturday</DayOfWeek> <DayOfWeek>Sunday or Monday or Tuesday or Wednesday or Thursday 
or Friday 
   or Saturday</DayOfWeek> </DaysOfWeek> <FirstDayOfWeek>Sunday or Monday or Tuesday or We
dnesday or Thursday or Friday 
   or Saturday</FirstDayOfWeek> <BySetPosition>int</BySetPosition> <PatternEndType>EndByDa
te or EndByInstances or EndNever or Default</PatternEndType> <PatternEndDateUTC>string</P
atternEndDateUTC> <FirstOccurrenceRecInstanceIdUTC>string</FirstOccurrenceRecInstanceIdUT
C> <PatternInstances>int</PatternInstances> <Exceptions> <RecurrenceException xsi:nil="tr
ue" /> <RecurrenceException xsi:nil="true" /> </Exceptions> </RecurrencePattern> <OwnerI
d>long</OwnerId> <OwnerUserName>string</OwnerUserName> <OwnerFirstName>string</OwnerFirst
Name> <OwnerLastName>string</OwnerLastName> <OwnerEmailAddress>string</OwnerEmailAddress> 
<ConferenceType>Reservation Only or Automatic Call Launch or Manual Call Launch 
  or Default or Ad-Hoc conference or One Button To Push</ConferenceType> <Bandwidth>1b/64k
bps or 2b/128kbps or 3b/192kbps or 4b/256kbps or 5b/320kbps 
  or 6b/384kbps or 8b/512kbps or 12b/768kbps or 18b/1152kbps or 23b/1472kbps 
  or 30b/1920kbps or 32b/2048kbps or 48b/3072kbps or 64b/4096kbps or Max or 
  Default</Bandwidth> <PictureMode>Continuous Presence or Enhanced CP or Voice Switched 
  or Default</PictureMode> <Encrypted>Yes or No or If Possible or Default</Encrypted> <Dat
aConference>Yes or No or If Possible or Default</DataConference> <ShowExtendOption>Yes or 
No or Default or AutomaticBestEffort</ShowExtendOption> <Password>string</Password> <Bill
ingCode>string</BillingCode> <ISDNRestrict>boolean</ISDNRestrict> <ConferenceInfoText>str
ing</ConferenceInfoText> <UserMessageText>string</UserMessageText> <ExternalSourceId>stri
ng</ExternalSourceId> <ExternalPrimaryKey>string</ExternalPrimaryKey> <Participants> <Par
ticipant> <ParticipantId>int</ParticipantId> <NameOrNumber>string</NameOrNumber> <Partici
pantCallType>TMS or IP Video <- or IP Tel <- or ISDN Video <- 
    or Telephone <- or IP Video -> or IP Tel -> or ISDN Video -> 
    or Telephone -> or Directory or User or SIP <- or SIP -> or SIP Tel <-
    or SIP Tel-> or 3G <- or 3G -> or TMS Master Participant
    </ParticipantCallType> </Participant> <Participant> <ParticipantId>int</ParticipantId> 
<NameOrNumber>string</NameOrNumber> <ParticipantCallType>TMS or IP Video <- or IP Tel <- 
or ISDN Video <- 
    or Telephone <- or IP Video -> or IP Tel -> or ISDN Video -> 
    or Telephone -> or Directory or User or SIP <- or SIP -> or SIP Tel <-
    or SIP Tel-> or 3G <- or 3G -> or TMS Master Participant
    </ParticipantCallType> </Participant> </Participants> <RecordedConferenceUri>string</R
ecordedConferenceUri> <ExternalConference> <WebEx> <MeetingKey>string</MeetingKey> <SipUr
l>string</SipUrl> <MeetingPassword>string</MeetingPassword> <JoinMeetingUrl>string</JoinM
eetingUrl> <HostMeetingUrl>string</HostMeetingUrl> <HostKey>string</HostKey> <JoinBeforeH
ostTime>string</JoinBeforeHostTime> <Telephony xsi:nil="true" /> <Errors xsi:nil="true" /
> </WebEx> </ExternalConference> <WebConferencePresenterUri>string</WebConferencePresente
rUri> <WebConferenceAttendeeUri>string</WebConferenceAttendeeUri> <ISDNBandwidth> <Bandwi
dth>1b/64kbps or 2b/128kbps or 3b/192kbps or 4b/256kbps or
   5b/320kbps or 6b/384kbps or 8b/512kbps or 12b/768kbps or 18b/1152kbps 
   or 23b/1472kbps or 30b/1920kbps or 32b/2048kbps or 48b/3072kbps 
   or 64b/4096kbps or Max or Default</Bandwidth> </ISDNBandwidth> <IPBandwidth> <Bandwidt
h>1b/64kbps or 2b/128kbps or 3b/192kbps or 4b/256kbps or 
   5b/320kbps or 6b/384kbps or 8b/512kbps or 12b/768kbps or 18b/1152kbps 
   or 23b/1472kbps or 30b/1920kbps or 32b/2048kbps or 48b/3072kbps 
   or 64b/4096kbps or Max or Default</Bandwidth> </IPBandwidth> 
<ConferenceLanguage>string</ConferenceLanguage> <ConferenceTimeZoneRules> <TimeZoneRule> 
<ValidFromdateTime</ValidFrom <Id>string</Id> <BaseOffsetInMinutes>int</BaseOffsetInMinut
es <Daylight xsi:nil="true" />
    <DaylightOffsetInMinutes>int</DaylightOffsetInMinutes> <Standard xsi:nil="true" />
   </TimeZoneRule> </ConferenceTimeZoneRules> </Conference>  
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Booking API functions
This reference section describes all the available functions of the booking API.

DeleteConferenceById 
Deletes a conference with the given ConferenceId (as defined in Cisco TMS). If the conference is part of a 
recurring series, the whole series will be deleted.

Supported parameters:

ConferenceId The ConferenceId of the conference to delete.

Returned data: Nothing.

DeleteConferenceRecInstanceById 
Deletes an occurrence of a recurring conference with the given ConferenceId (as defined in Cisco TMS). This 
function is typically used when deleting a single meeting in a recurring series.

Supported parameters:

ConferenceId The ConferenceId of the conference to delete.

Returned data: Nothing.

If the provided ID does not exist, this will cause an error. See the section Error codes and error handling 
[p.53].

EndConferenceById 
Ends an ongoing conference with the given ConferenceId (as defined in Cisco TMS). The conference will be 
set to Finished, and the end time will be set to the time of execution of the function. This function is typically 
used to end a running conference from a third party front-end GUI. The function will fail with an error if the 
conference has not yet started.

Supported parameters:

ConferenceId The ConferenceId of the conference to delete.

Returned data: Nothing.

If the provided ID does not exist, this will cause an error. See the section Error codes and error handling 
[p.53].

GetConferenceById 
Get the available information about a particular conference.

Supported parameters:

ConferenceId The ID of the conference (Based on Cisco TMS IDs)
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Returned data: A Conference object based on the ConferenceId.

If the provided ID does not exist, this will cause an error. See the section Error codes and error handling 
[p.53].

GetConferencesForUser
This function returns all conferences owned by a particular user between two dates. 

Supported parameters:

UserName The Cisco TMS user to get bookings for. If no user name is provided (empty string), the 
logged in user is used.

StartTime The start date and time of bookings.

EndTime The end date and time of bookings.

ConferenceStatus An enumeration of what type of conferences that will be fetched from Cisco TMS. The 
available types are:

 n All
 n AllExceptDeleted
 n Pending
 n Ongoing
 n PendingAndOngoing 
 n MeetingRequest
 n Rejected
 n Finished
 n Deleted

Returned data: An array with Conference objects. 

The conference objects will not include:

 n the list of participants
 n WebEx conference information
 n recording URIs
 n ConferenceInfoHtml or ConferenceInfoText

GetConferenceBookingEventMail
Supported parameters:

Message A message from the client to inject into the email notification. 

Contains:

 n A MessageType which determines the color and prefix of the message box at the top of the 
email message. Supported values are Information (green), Warning (yellow), and Error (red).

 n One or more lines of text strings containing the actual message.
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ContentTypes Determines whether the email notification will be sent as PlainText or Html.

Language A list of supported languages can be gotten from the Remote Setup API. See 
GetConferenceLanguages [p.28].

Returned data: A list of conference booking event e-mail content. Setting Language to blank will return the 
conference language. 

GetConferenceIdByExternalId 
This function is used to look up a conference that has been updated in the external source, and that must be 
updated in Cisco TMS. The ExternalSourceId and ExternalPrimaryKey fields must have been 
provided with the initial performance of the SaveConference function.

This function is typically used when information about a conference reserved in the external application is 
needed. First this function is call to get the corresponding conference is Cisco TMS. The GetConferenceById 
is used to get information about the conference from Cisco TMS.

Supported parameters:

ExternalSourceId Unique identifier of the external source (server IP address).

ExternalConferenceId Unique identifier of the conference within the external source (primary key in 
database).

RecurrenceIdUTC Identifies an instance in a series of conferences. A UTC-formatted datetime string. 
Only UTC times, ending with Z, are supported. Example: 1975-06-0123:32:11Z.

Returned data: A ConferenceId, as defined in Cisco TMS.

GetConferenceInviteMail
Use this to get Cisco TMS to send conference invites, which may embed messages from the client.

Supported parameters:

Messages You can inject one or more messages from the client into the invitation email.

The following message types are supported: 

 n Information: Will be presented on a green background if sent as HTML.
 n Warning: Will be presented on a yellow background if sent as HTML.
 n Error: Will be presented on a red background if sent as HTML.

 

ContentTypes PlainText or Html

Language A list of supported languages is in the remote setup API. See GetConferenceLanguages [p.28]

Returned data: A list of conference invitation e-mail content. Setting Language to blank will return the 
conference language.
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GetConferencesForSystems
This function returns all conferences for a list of systems between two dates. It is typically used to build a 
display of resource availability information in external application for a specific system when the external 
application does not store its own resource availability information.

The function should be used with caution. If a large number of conferences are booked between the two 
dates in Cisco TMS, it will take a long time to process the result of this function.

Supported parameters:

SystemIds An array of IDs of the systems, based on Cisco TMS IDs.

StartDate The start date of bookings

EndDate The end date of bookings

ConferenceStatus An enumeration of the type of conferences that will be fetched from Cisco TMS. The 
available types are: 

 n All
 n AllExceptDeleted
 n Pending
 n Ongoing
 n PendingAndOngoing
 n MeetingRequest (Conference has been requested by a user without booking rights, 

needs approval.)
 n Finished
 n Deleted

Returned data: An array with Conference objects. As of API version 11, this includes scheduled 
conferences only, no ad hoc conferences.

 
The conference objects will not include:

 n the list of participants
 n WebEx conference information
 n recording URIs
 n ConferenceInfoHtml or ConferenceInfoText

If the provided ID does not exist, this will cause an error. See the section Error codes and error handling 
[p.53].

GetDefaultConference
Creates a default conference object with ID equals -1 based on the conference settings specified in Cisco 
TMS. 

This function is typically used as a basis for new meetings, where all that is needed is to define the start and 
end time, along with the participants in the conference.

Supported parameters: None
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Returned data: A Conference object using the default values defined in Cisco TMS. 

 n The start time of the conference is set to the current time. 
 n The end time is set to the start time + Default Scheduled Call Duration (in minutes) as configured in  

Administrative Tools > Configuration > Conference Settings.
 n If, in Administrative Tools > Configuration > WebEx Settings, the setting for Add WebEx To All 

Conferences is Yes, the default conference will always include WebEx, whether or not this is exposed to 
the user by the client. For more information about including WebEx, see ExternalConference [p.37].

GetRecordingAliases
Supported parameters:

UserName The user to retrieve recording alias for. If no UserName is provided (empty string), the logged in user 
will be used.

Returned data: An array of RecordingDevice, where the key is the string representation of a recording 
device name, or a recording cluster name. The value is an array of AliasInfo for that particular recording 
device/cluster, holding an AliasId (string) and a SystemId (int) . The AliasId and SystemId can be used to add 
a recording participant to a conference.

GetRecurrentConferenceById 
Returns a Conference object with the given ConferenceId.  If the conference is a recurrent conference, 
existing exceptions to the recurrent series are returned in the RecurrencePattern Exceptions array of the 
returned Conference object.

Supported parameters:

ConferenceId The ID of the conference, based on TMS IDs.

Returned data: A Conference object based on the ConferenceId.

If the provided ID does not exist, this will cause an error. See the section Error codes and error handling 
[p.53].

GetTimeZoneRulesById
Get the available time zone rules for the given time zone.

Supported parameters:

idString A string containing the ID of the time zone on the Cisco TMS server.

Returned data: An array of TimeZoneRule elements

If the provided ID does not exist, this will cause an error. See the section Error codes and error handling 
[p.53].
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GetTransactionsSince 
This function is used to get a list of conference creations, updated and deletions that must be performed in 
order to keep a mirrored conference database synchronized. The transaction identified as 
CurrentTransactionId will not be included in the array.

Supported parameters:

CurrentTransactionId The transaction ID of the last committed transaction of the last synchronization.

Returned data: An array of transactions since the CurrentTransactionId.

If the provided ID does not exist, this will cause an error. See the section Error codes and error handling 
[p.53].

SaveConference 
This function saves a conference in Cisco TMS.

 n If ConferenceId is not set, a new conference is created and saved. 
 n If ConferenceId is set, the existing conference is updated. If the provided ID is incorrect, an error is 

caused. See the section Error codes and error handling [p.53].

The function will fail in both of the following scenarios: 

 n One or more of the participants are already booked in the same time period.
 n A call route is to be made, but no call route could be found.

If this function is performed on a recurring conference, the entire series is affected.

Supported parameters:

Conference The Conference object to be created/updated.

Returned data: A Conference object updated with actual values saved in Cisco TMS.

SaveConferenceRecInstance
Saves an instance of a recurring conference in Cisco TMS. Similar to SaveConference.

Supported parameters:

Conference The Conference object to be created/updated

Returned data: A Conference object updated with actual values saved in Cisco TMS.

SaveConferences
Saves a list of conferences to Cisco TMS, with the option to save either all or none depending on availability 
information. 
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Use this function if the recurrence pattern of the Conference object does not support the recurrence model in 
the external application.

Supported parameters:

Conference An array of conference objects.

oneTransaction True if the objects should be booked as one transaction, meaning that either all or none of 
the meetings will be booked depending on the free/busy information. Currently only true is 
supported for this function. 

Returned data: An array of Conference objects updated with actual values saved in Cisco TMS.         
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Error codes and error handling

This chapter provides an overview of the available error codes as well as an error handling example.

Error codes 54
Error handling 56
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Error codes
Error Code Description

LICENSE -2147219503 Client attempts to book more systems than there are 
licenses for.

DATABASE_DOWN -2147219500 There is a problem with the Cisco TMS database.

MEETINGNOTFOUND -2147218302 Client tries to access (get or update) a conference that does 
not exist.

SYSTEMNOTFOUND -2147218301 Client tries to access (get or update) a system/participant 
that does not exist in Cisco TMS.

SYSTEM_ALREADY_BOOKED -2147218300 Client tries to schedule a participant that has already been 
scheduled.

SYSTEM_NOT_ALLOWED_IN_
BOOKING

-2147218262 Client tries to book a system that the user does not have 
booking rights for, or the system has Allow Bookings set to 
False.

MEETINGNOTACTIVE -2147218272 Client tries to end a conference that is not active.

MEETINGISDELETED -2147218271 Client tries to end a conference that has been deleted.

MEETINGACTIVE -2147218270 Client tries to modify the start time of a conference that is 
already active.

CANNOTBOOKINTHEPAST -2147218269 Client tries to book a conference with an end time that is in 
the past.

NO_ACCESS_TO_
CONFERENCE

-2147218266 Client tries to get a conference, but the user does not have 
the permissions in Cisco TMS to read all conferences.

START_TIME_AFTER_MAX_
NUMBER_OF_DAYS_IN_
FUTURE

-2147218265 Client tries to save a outside of the booking window set in 
Cisco TMS.

NEVER_ENDING_
RECURRENCE_NOT_
SUPPORTED

-2147218264 Client tries to save a conference with a "NeverEnding" 
recurrence end type, which is not supported.

START_TIME_AFTER_END_TIME -2147218263 Client tries to save a conference where the start time is later 
than the end time.

INVALID_TIMEZONE_INFO -2147218268 The specified time zone information is not valid.

WEBEX_SITE_NOT_FOUND -2147218267 No WebEx site connected to user in Cisco TMS.

WEBEX_ERROR -2147218260 Any other error regarding WebEx.

SECURITY -2147218259 Client tries to modify or delete a conference, but the user 
does not have the required permissions in Cisco TMS.

SERVER_BUSY -2147218258 Cisco TMS is currently unable to handle client's request to 
save a conference.

UNKNOWN -2147218261 Any exception not covered by other error codes.

If an exception is thrown, the exception message will contain the reason. If you get an Unspecified 
Exception/Unspecified Error, this usually means that there is a syntax flaw in the conference sent to the 
SaveConference function. In such a case, an error description would be given in the Cisco TMS log files, 
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which you can download from the Cisco TMS website, or locate in the folder 
(/tms/data/logs/tmsdebug/log-web.txt) on the Cisco TMS server.
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Error handling
If the Cisco TMS server is operational with the proper licenses, errors are caused by sending the wrong 
parameters to the API, such as trying to create a booking in the past, or trying to get systems, users, or 
conferences from Cisco TMS using the wrong ID. When an exception is caught, it is generally an indication 
that the client call must be changed before it is sent again.

Exceptions
All errors generated from the API are SoapExceptions, hence each time a save operation is performed 
against the API, the code should handle exceptions of type SoapException.

The message field of the exception will contain a string with a description of what went wrong. In many 
cases, displaying this information to the user will be helpful.

HTTP error 401
The server will normally return the HTTP error code 500 Internal Server Error for the SoapExceptions.

If the HTTP error code 401 Unauthorized is received,  the user credentials supplied were not authorized to 
access the server.
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Code examples

This chapter provides examples of how to apply the remote setup API and the booking API in your 
development.

Code examples are provided in C#.

Remote setup API examples 58
Booking API setup 59
Using different participant types 60
Booking API example with a recording participant 61
Saving and updating recurrent conferences 62
Time zone handling 63
Error handling examples 65
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Remote setup API examples
The code snippet below demonstrates how to authenticate with the remote setup API.

public void InitRemoteSetupService()
 {
     // Specify username and password to authenticate to service.
     // (Can also be done in web.config) 
     NetworkCredential credentials = new NetworkCredential("username", "password", "domain");
 
     remoteSetupService = new RemoteSetupService { Credentials = credentials };            
     if (remoteSetupService.ExternalAPIVersionSoapHeaderValue == null)
     {
         remoteSetupService.ExternalAPIVersionSoapHeaderValue = new RemoteSetupServiceWS.ExternalAPIVers
ionSoapHeader();
     }
     remoteSetupService.ExternalAPIVersionSoapHeaderValue.ClientVersionIn = 11;
 }

The code snippet below demonstrates how to loop through all systems in Cisco TMS, and display 
information about each system.

public void DisplaySystemInformation()
 {
     InitRemoteSetupService();
     // Get all systems from TMS 
     RemoteSetupServiceWS.TMSSystem[] tmsSystems = remoteSetupService.GetSystems(); 
     // Loop through the systems and output information about each system foreach (RemoteSetupServiceWS.
TMSSystem tmsSystem in tmsSystems)
     {
         Console.Out.WriteLine("SystemId: " + tmsSystem + " System Name:" + tmsSystem.SystemName);
     }            
 }
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Booking API setup
The code snippet below demonstrates how to authenticate with Cisco TMSBA and specify the version.

public void InitBookingService()
 {
     // Specify username and password to authenticate to service. 
     // (Can also be done in web.config) 
     NetworkCredential credentials = new NetworkCredential("username", "password", "domain");
                                                                         
     bookingService = new BookingService {Credentials = credentials};
     if (bookingService.ExternalAPIVersionSoapHeaderValue == null)
     {
         bookingService.ExternalAPIVersionSoapHeaderValue = new ExternalAPIVersionSoapHeader();
     }
     bookingService.ExternalAPIVersionSoapHeaderValue.ClientVersionIn = 11;             
 }
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Using different participant types
When using the API as a web reference, the participant types, such as "IP Video", "ISDN Video", and so on 
are created as enumerations called, for example, IPTel, IPTel1. Values ending in 1 are dial-out, values not 
ending in 1 are dial-ins.

The code snippet below shows how to create a conference with three different participant types. An MCU is 
required for this call to be saved.

public void SaveConferenceWithVariousParticipantTypes()
 {
     InitBookingService();
     // Get a default conference object from TMS, where most common values are set
     // (using default values specified in TMS)
     Conference conference = bookingService.GetDefaultConference();
     
     // Create and initialize an array of conference participants, and add it to the conference
     conference.Participants = new[]
         {
             new Participant
                 {
                     // Adds a SIP Dial-in participant
                     NameOrNumber = "SIP Dial-in 1", ParticipantCallType = ParticipantType.SIP
                 },
             new Participant
                 {
                     // Adds a SIP Dial-out participant
                     NameOrNumber = "manager1@example.com", ParticipantCallType = ParticipantType.SIP1
                 },
             new Participant
                 {
                     // Adds a TMS participant (endpoint)
                     ParticipantCallType = ParticipantType.TMS, ParticipantId = 4
                 }
         };
 
     // Save the conference, saving the returned conference (where all values are now specified)
     conference = bookingService.SaveConference(conference);
 
     PrintConferenceInformation(conference);
 }
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Booking API example with a recording participant
The code snippet below demonstrates how to create a conference with two participants. One of the 
participants is a recording participant, the other  a video system registered in TMS.

public void SaveConferenceWithRecordingParticipant()
 {
     InitBookingService();
     Conference conference = bookingService.GetDefaultConference(); 
     
     // Create the elements of the array (the actual participants)
     // Create one dial-out participant
     Participant dialOutParticipant = new Participant {ParticipantCallType = ParticipantType.IPVideo1, N
ameOrNumber = "10.0.1.2"};
     // Get the recording aliases for the logged in user
     RecordingDevice[] recordingDevicesWithAliases = bookingService.GetRecordingAliases(""); 
     Participant recordingParticipant = new Participant();
     bool foundAliasInformation = false;
     if (recordingDevicesWithAliases != null && recordingDevicesWithAliases.Any())
     {
         // use the first recording device in the arrayvar recordingAlias = recordingDevicesWithAliases.
First();
         if (recordingAlias.Aliases != null && recordingAlias.Aliases.Any())
         {
             foundAliasInformation = true;
             // use the first alias found on the first recording device 
             AliasInfo aliasInfo = recordingAlias.Aliases.First();
             recordingParticipant.ParticipantCallType = ParticipantType.TMS;
             recordingParticipant.ParticipantId = aliasInfo.SystemId;
             recordingParticipant.NameOrNumber = aliasInfo.AliasId;
         }
     }
 
     if (foundAliasInformation)
     {
         conference.Participants = new []
             {
                 dialOutParticipant,
                 recordingParticipant
             };
     }
     else
     {
         // no alias information found in TMS
         conference.Participants = new[]
             {
                 dialOutParticipant
             };
     }
 
     // Save the conference, saving the returned conference (where all values are now specified) 
     conference = bookingService.SaveConference(conference);
 
     PrintConferenceInformation(conference);
 }
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Saving and updating recurrent conferences
The code snippet below demonstrates how to save/update a conference series.

public void SaveAndUpdateRecurrentConference()
 {
     InitBookingService();
     Conference conference = bookingService.GetDefaultConference();
 
     // Set the conference to start in the future (default is now)
     var start = DateTime.Now.AddHours(1);
     var end = start.AddMinutes(10);
 
     conference.StartTimeUTC = start.ToString("u");
     conference.EndTimeUTC = end.ToString("u");
 
     conference.Participants = new []
         {
             new Participant{ParticipantCallType = ParticipantType.SIP, NameOrNumber = "Sip dial-in 1"},
             new Participant{ParticipantCallType = ParticipantType.SIP, NameOrNumber = "Sip dial-in 2"}
         };
 
     // setup the recurrence pattern
     conference.RecurrencePattern = new RecurrencePattern
         {
             FrequencyType = RecurringFrequency.Daily,
             PatternEndType = RecurrenceEndType.EndByInstances,
             PatternInstances = 10,
         };
     // Save the conference, saving the returned conference (where all values are now specified) 
     conference = bookingService.SaveConference(conference);
 
     // update the conference, change the pattern from Daily to Weekly and change from 10 instances to 5
     conference.RecurrencePattern = new RecurrencePattern
     {
         FrequencyType = RecurringFrequency.Weekly,
         PatternEndType = RecurrenceEndType.EndByInstances,
         PatternInstances = 5,
     };
 
     conference = bookingService.SaveConference(conference);
     
     PrintConferenceInformation(conference);
 }
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Time zone handling
The code snippets in this section demonstrate how to save a regular and a custom set of time zone rules.

Regular time zone
public void SaveConferenceWithRegularTimeZone()
 {
     InitBookingService();
     Conference conference = bookingService.GetDefaultConference();
     var start = DateTime.Now.AddHours(1);
     var end = start.AddMinutes(10);
 
     conference.StartTimeUTC = start.ToString("u");
     conference.EndTimeUTC = end.ToString("u");
 
     conference.RecurrencePattern = new RecurrencePattern
     {
         FrequencyType = RecurringFrequency.Daily,
         Interval = 1,
         PatternEndType = RecurrenceEndType.EndByInstances,
         PatternInstances = 3,
     };
 
     try
     {
         TimeZoneRule[] timeZoneRules = bookingService.GetTimeZoneRulesById("Central Standard Time");
         if (timeZoneRules != null && timeZoneRules.Length > 0)
         {
             conference.ConferenceTimeZoneRules = timeZoneRules;
             conference = bookingService.SaveConference(conference);
 
             PrintConferenceInformation(conference);
         }
     }
     catch (Exception)
     {
         Console.WriteLine("TMS did not return any time zone information for given time zone id");        
        
     }
 }

Custom time zone
public void SaveConferenceWithCustomTimeZone()
 {
     Conference conference = bookingService.GetDefaultConference();
     var start = DateTime.Now.AddHours(1);
     var end = start.AddMinutes(10);
 
     conference.StartTimeUTC = start.ToString("u");
     conference.EndTimeUTC = end.ToString("u");
 
     conference.RecurrencePattern = new RecurrencePattern
     {
         FrequencyType = RecurringFrequency.Daily,
         Interval = 1,
         PatternEndType = RecurrenceEndType.EndByInstances,
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         PatternInstances = 10,
     };
 
     conference.ConferenceTimeZoneRules = new[]
     {
         new TimeZoneRule
            {                                                           
                 Id = "My custom rule",
                 BaseOffsetInMinutes = 60,
                 DaylightOffsetInMinutes = 60,
                 ValidFrom = DateTime.MinValue,
                 Daylight = new TimeChange
                 {
                     ChangeSecondAtDay = 2*60*60, // Daylight changes at 02:00 am
                     AbsoluteRule = new TimeChangeAbsoluteRule
                     {
                         Month = 3,
                         DayOfMonth = 3,
                     }
                 },
                 Standard = new TimeChange
                 {
                     ChangeSecondAtDay = 10*60*60, //// Daylight changes at 10:00 am
                     RelativeRule = new TimeChangeRelativeRule
                     {
                         Month = 10,
                         DayOfTheWeek = 0, // Sunday
                         WeekOfTheMonthIndex = 5, // Last
                     }
                 }
             }
     };
     conference = bookingService.SaveConference(conference);
 
     PrintConferenceInformation(conference);
 }
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Error handling examples
The following code examples demonstrate how to handle errors generated from API calls.

Conference in the past
Running this code will output the message: "You cannot book a conference in the past".

public void HandleError_BookInThePast()
 {
     InitBookingService();
     Conference conference = bookingService.GetDefaultConference();
     var start = DateTime.Now.AddHours(-10);
     var end = start.AddMinutes(10);
 
     conference.StartTimeUTC = start.ToString("u");
     conference.EndTimeUTC = end.ToString("u");
 
     try
     {
         conference = bookingService.SaveConference(conference);
     }
     catch (SoapException e)
     {
         Console.WriteLine("Got error with error code {0}, and message {1}, from Booking API", e.Detail.
InnerXml, e.Message);
     }
     
     PrintConferenceInformation(conference);
 }

System unavailable
Running the code below will output a "system unavailable" message.

public void HandleError_SystemNotAvailable()
 {
     InitBookingService();
     Conference conference = bookingService.GetDefaultConference();
     var start = DateTime.Now.AddHours(1);
     var end = start.AddMinutes(10);
 
     conference.StartTimeUTC = start.ToString("u");
     conference.EndTimeUTC = end.ToString("u");
 
     Participant participant = new Participant {ParticipantCallType = ParticipantType.TMS, ParticipantId 
= 4};
 
     conference.Participants = new []
         {
             participant
         };
     bookingService.SaveConference(conference);
 
     try            
     {
         // By setting the Id to -1, we try to book a new conference, with the same time and participant
         conference.ConferenceId = -1;
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         conference = bookingService.SaveConference(conference);
     }
     catch (SoapException e)
     {
         Console.WriteLine("Got error with error code {0}, and message {1}, from Booking API", e.Detail.
InnerXml, e.Message);
     }
 
     PrintConferenceInformation(conference);
 }   
  
private static void PrintConferenceInformation(Conference conference)
 {
     // Output information about the conference. 
     Console.Out.WriteLine(conference.ConferenceInfoText);
     Console.Out.WriteLine(conference.UserMessageText);
     Console.Out.WriteLine(conference.ConferenceId);
 }
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